WELCOME TO THE WORLD OF LEGO® MINDSTORMS®

Congratulations on your new LEGO® MINDSTORMS® NXT robotics tool set. You now have the power to build and program robots that do what you want!

Dream it, build it
Your MINDSTORMS NXT set enables you to create thousands of robotic inventions. Intelligent robots that can see, speak, feel and move. Cool robots that guard your room and do your chores. If you can dream it, you can build it!

Build. Program. Go!
Creating a MINDSTORMS robot is easy. Build the robot using your LEGO elements. Program it using the easy-to-use software and watch your robot come alive. For your first robotic adventure, try out the quick-build model that you can build and program in less than 30 minutes.

Smart technologies
Your MINDSTORMS NXT set features the latest in robotic technology: an advanced 32-bit programmable microcontroller; icon-based drag-and-drop programming software and interactive challenges; smart sensors and Interactive Servo Motors; wireless Bluetooth and USB connection. In fact, all the smart technologies you need to create your dream robot.

MINDSTORMS.com
You are now a part of the worldwide LEGO MINDSTORMS community. Log on to MINDSTORMS.com and get more robotic challenges. Download programs, sound effects and other cool stuff. Share your inventions and exchange tips and tricks with other MINDSTORMS users.
www.MINDSTORMS.com is your new robotic hot spot.

Find out more
In this User Guide you can learn more about the technology and the many exciting features in your MINDSTORMS set.

Have fun building your own amazing robots!

The LEGO MINDSTORMS team.
## CONTENTS

### INTRODUCTION
- Build, Program, Go! ........................................... 4
- Building instructions ............................................ 5

### NXT TECHNOLOGY
- NXT technology overview ................................... 16
- Connecting the NXT technology ............................ 18
- About the NXT .................................................. 20
- Installing batteries in your NXT ........................... 22
- NXT main menu ............................................... 23
- Color Sensor & Color Lamp ................................... 30
- Touch Sensor ..................................................... 32
- Ultrasonic Sensor ............................................... 33
- Interactive Servo Motors ..................................... 34
- Using Bluetooth ................................................. 36

### SOFTWARE
- System requirements .......................................... 46
- Installing the software ........................................ 46
- Your first program ............................................ 48
- Software user interface ....................................... 50
- The Robo Center ............................................... 52
- The programming palette .................................... 53
- The configuration panel ...................................... 55
- The Controller .................................................. 55
- Sound Editor .................................................... 56
- Image Editor ..................................................... 57
- Remote Control ................................................ 58

### USEFUL INFORMATION
- Test Pad ......................................................... 59
- Troubleshooting ................................................ 60
- Disposal Guide ................................................ 62
- Element overview ............................................ 63
BUILD. PROGRAM. GO!

**Build**
Build a robot. You can find building instructions for this model (Quick Start kit) in this User Guide, in the software or at www.MINOSTORMS.com. Or you can use your imagination to build your own unique robot.

**Program**
Program your robot to do what you want. Use the LEGO® MINDSTORMS® NXT Software to create a program. Download the program to the NXT by using the USB cable or the wireless Bluetooth connection.

**Go!**
Run the program and watch your robot come to life.

**Quick Start**
Use the Quick Start kit to get your first MINDSTORMS experience. In the Quick Start kit you will find everything you need to get off to a great start. It will only take you a few minutes to create your first MINDSTORMS robot, test it, and get a fun reaction.

The building instructions for your first robot starts on page 5 (opposite).
1

2
NXT TECHNOLOGY OVERVIEW

The NXT
The NXT is an intelligent, computer-controlled LEGO® brick and the brain of the MINDSTORMS® robot.

Touch Sensors
Enables the robot to feel and react to its environment.

Color Sensor
Enables the robot to detect colors and light. Can also be used as a color lamp.
Interactive Servo Motors
Ensure that the robot moves with precision.

Ultrasonic Sensor
Enables the robot to see, measure distance to an object, and react to movement.

Standard port settings for sensors and motors
To make your robot work correctly, the sensors and motors should be connected to specific input and output ports. Here are the standard port settings:

**Input ports**
- Port 1: Touch Sensor
- Port 2: Touch Sensor
- Port 3: Color Sensor
- Port 4: Ultrasonic Sensor

**Output ports**
- Port A: Motor used for an extra function
- Port B: Motor for movement
- Port C: Motor for movement
CONNECTING THE NXT TECHNOLOGY

Connecting motors
To connect a motor to the NXT, use one of the black 6-wire cables. Attach one end of the cable to the motor and the other to one of the NXT’s output ports (A, B, or C).

Connecting sensors
To connect a sensor to the NXT, use one of the black 6-wire cables. Attach one end of the cable to the sensor and the other to one of the NXT’s input ports (1, 2, 3, or 4).

Downloading and uploading
The USB port and wireless Bluetooth connection let you download and upload data between your computer and the NXT. If your computer has Bluetooth capability, you can download programs to the NXT without using the USB cable. If your computer does not have Bluetooth capability, you must use the USB cable or install a Bluetooth USB dongle on your computer.

NOTE: Read more about wireless Bluetooth communication on page 36.
Connecting the NXT to a PC with a USB cable

Turn on the NXT.

Connect the PC and the NXT with the USB cable.

When the PC identifies the NXT it will automatically finalize the installation of the LEGO MINDSTORMS NXT Software.

The USB connection must be made by an adult or under supervision of an adult.

Connecting the NXT to a Macintosh with a USB cable

Make sure that the LEGO MINDSTORMS NXT Software is installed before connecting your NXT to your Macintosh (see page 47).

Turn on your NXT.

Connect the USB cable to the NXT.

Connect the USB cable to the Macintosh and you’re ready to go.
ABOUT THE NXT

The NXT is the brain of a MINDSTORMS® robot. It's an intelligent, computer-controlled LEGO® brick that lets a MINDSTORMS robot come alive and perform different operations.

Please note that all text on the NXT display is in English.

Motors ports
The NXT has three output ports for attaching motors. To make the motor work, the motors need to be attached to part A, B or C.

Bluetooth icon
The Bluetooth icon shows the current status of any wireless Bluetooth connections. If there is no Bluetooth icon shown, Bluetooth is OFF.

Bluetooth is ON and your NXT is visible to other Bluetooth devices.

Bluetooth is ON and your NXT is connected to a Bluetooth device.

USB icon
When you connect your NXT to a computer with a USB cable, a USB icon will be displayed. If you disconnect the USB cable, the icon will disappear.

USB
USB connected and working fine.

USB connected but not working properly.

Sensor ports
The NXT has four input ports for attaching sensors. The sensors need to be attached to port 1, 2, 3 or 4.

USB port
Connect a USB cable to the USB port and download programs from your computer to the NXT (or upload data from the robot to your computer). You can also use the wireless Bluetooth connection for uploading and downloading.
**NXT TECHNOLOGY**

**Naming the NXT**
You can change the name of your NXT by going to the NXT window in the software. This window is accessible from the Controller. NXT names can be at most eight characters long.

**Battery level**
The battery icon displays the power level of the NXT. When battery power is low, the battery icon will flash on and off.

**Running icon**
When your NXT is turned on, the running icon will spin. If the running icon stops spinning, your NXT has frozen and you will need to reset it (see page 50, Troubleshooting).

**Loudspeaker**
Make a program with real sounds and listen to them when you run the program.

**NXT buttons**
- Orange button: On/Off
- Light grey arrow: Used for moving left and right in the NXT menu.
- Dark grey button: Clear/Go back

**Turning off your NXT**
Push the dark grey button repeatedly until you see the screen on the right. Push the orange button to turn off your NXT, push the dark grey button to go back to the main menu.

**NXT display options**
Your NXT has many other cool features. Read more about them on the following pages.

---

**Technical specifications**
- 32-bit ARM7 microcontroller
- 256 Kbytes FLASH, 64 Kbytes RAM
- 8-bit AVR microcontroller
- 4 Kbytes FLASH, 512 Byte RAM
- Bluetooth wireless communication (Bluetooth Class II V2.0 compliant)
- USB full speed port (12 Mbit/s)
- 4 input ports, 6-wire cable digital platform (One port includes an ICC 51150 Type 4/EN 50170 compliant expansion port for future use)
- 3 output ports, 6-wire cable digital platform
- 100 x 64 pixel LCD graphical display
- Loudspeaker - 8 kHz sound quality, Sound channel with 2-bit resolution and 2-16 kHz sample rate.
- Power source: 6 AA batteries

*Note* A rechargeable battery pack is available for the NXT on [www.shop.LEGO.com](http://www.shop.LEGO.com).
INSTALLING BATTERIES IN YOUR NXT

Battery type
- The NXT requires 6 AA/LR6 batteries to function properly.
- Alkaline batteries are recommended.
- Rechargeable batteries can be used, but the NXT’s power may be reduced, making the motors turn more slowly.

The normal function of the product may be disturbed by Strong Electro Magnetic Interference. If so, simply reset the product to resume normal operation by following the instruction manual (see page 60, Troubleshooting). In case the function could not resume, please use the product in another location.

Low battery power
When battery power is low, this icon will pop up on the NXT’s display screen.

Important information about batteries
Never use different types of batteries together, or a combination of old and new batteries. Always remove the batteries if the product is not to be used for a long time or if the batteries have run down. Never use damaged batteries. Only use batteries of the type recommended, or a corresponding type. Insert the batteries so that the poles are correctly positioned.

Rechargeable batteries must be recharged using the correct battery charger under the supervision of an adult. You cannot recharge batteries while they are still in the product, and you must never try to do so.
Never attempt to recharge non-rechargeable batteries.
Never short-circuit the battery holder.
NXT MAIN MENU
My Files

The My Files submenu will let you see all of the programs you have made on the NXT or downloaded from your computer.

Software files
Software files - programs you have downloaded from your computer

NXT files
NXT files - programs you have made on the NXT

Sound files
Sound files

Datalog files
Datalog files - files generated when you use datalog

Files will automatically be placed in the appropriate subfolders. When you download a program including a sound file to your NXT, the program will be placed under Software files, while the sound data will be placed under Sound files. You can send files to other NXTs. Read more about this on page 44.
NXT Program

You don’t need a computer to program your robot. Using the NXT Program submenu, you can make thousands of different programs without your computer.

Try this simple program and see how easy it is:

Make the robot go back and forth when its Touch Sensor is pressed. First, the robot will move forward until the Touch Sensor is pressed, and then it will move backwards. When its Touch Sensor is pressed again, the robot will move forward once again. This will continue indefinitely until you stop the program.

Make sure that your sensors and motors are connected to the right ports.

Select Forward. Use the arrow buttons to move through the choices and then press the orange button (Enter) to make your selection.

Select Touch.

Select Backward.
Select Touch again.

Now select if you want the program to loop. This means that the program will run again and again until you switch off the NXT. For our little test, select Loop.

Now you can run your program. Simply select Read.

Try these programs as well:

1. 

2. 

3. 

Note:
Using the Color Sensor together with "Light Icon" will give a positive result when the sensor detects a white color. Using the Color Sensor together with the "Black Icon" will give a positive result when the sensor detects any other color than white.

4. 

UK-8547_MB_User_Guide_09.indd 25
30949 10:29:47 AM
Try Me

The Try Me submenu lets you test your sensors and motors in a fun way:

Connect the sensors and motors to the appropriate ports on the NXT. Important: Use the standard settings for the ports as explained on page 17.

Select a program.

When you press the orange [Enter] button, you will get some fun reactions from the sensors and motors.

Explore other Try Me programs to get some more fun sounds, to display images and to experience different motor reactions.

You can always delete these Try Me files again using the Settings submenu.
The View submenu lets you carry out a quick test of your sensors and motors, observing real-time data from each unit.

Connect the sensor or motor you would like to test to the NXT - the View submenu will help you select the right port or check standard settings on page 17. Select View on the NXT’s display.

Select the icon of the sensor or motor you would like to test. You can only get readings from one sensor or motor at a time.

Select the port that the sensor or motor is attached to.

The data from the sensor or motor will appear on the display.
Settings

The Settings submenu lets you adjust the NXT’s settings including its speaker volume or the Sleep mode setting. This submenu will also let you delete programs that have been stored in the NXT’s memory.

Sleep mode: You can set the NXT to turn itself off after 2, 5, 10, 30 or 60 minutes of inactivity (time when it’s not in use). You can also select the Never setting so that it remains on indefinitely (until you turn it off). Please be aware that the Never setting will drain your batteries more quickly.

Change volume: Here you can adjust the volume of the NXT’s speakers.

Delete all programs: You are able to delete all downloaded programs in the 4 subfolders: Software files, NXT files, Sound files and DataLog files, from the Settings submenu.
Bluetooth

The Bluetooth submenu will let you make a wireless connection between your NXT and other Bluetooth devices (like other NXTs and computers). You can use a wireless Bluetooth connection to send programs to other NXTs, to download programs from your own computer without using a USB cable, or other cool things like using the Remote Control in the software to get direct control of your robot and send it on missions!

Read more about wireless Bluetooth communications on page 36.
COLOR SENSOR

The Color Sensor is one of the sensors that gives your robot vision (the Ultrasonic Sensor is the other). The Color Sensor actually has three different functions in one. The Color Sensor enables your robot to distinguish between colors and light and dark. It can detect 6 different colors, read the light intensity in a room and measure the light intensity of colored surfaces. The Color Sensor can also be used as a Color Lamp.

Suggestions for use
You can use the Color Sensor to sort your LEGO® bricks, or to make a robot that will follow a red line or change direction when it detects a red spot. You can also use the sensor as a color lamp to give your robot extra personality.

Using the sensor as a color sensor
To get optimal color detection, the sensor should be held at a right-angle approximately 1 cm to the surface. Incorrect color readings can occur if the sensor is held at other angles to the surface or if it is used in bright light.
Using the sensor as a Light Sensor
The sensor can be used to take single light intensity readings. It functions as a light sensor when the light color is set to red. Using another light color (green or blue) can give different results.

The sensor can be used to take readings of light intensity from ambient or reflected light. Any of the three colors can shine when reading reflected light.

Using the sensor as a Color Lamp
You can use the sensor as a color lamp to control the individual output colors (red, green or blue) and add personality to your robot.

Test it!
You can test the color sensor in different ways:
Connect the color sensor to the NXT.

Select the View submenu on the NXT’s display. Select the color sensor icon and the part where you have connected the sensor.

Hold the color sensor approximately 1 cm above the different colors on the Testpod, and the NXT’s display will show the value and name of the color.

Select the Try My submenu on the NXT’s display and test your Color Sensor. You’ll get a fun reaction.
The Touch Sensor gives your robot a sense of touch. The Touch Sensor detects when it is being pressed by something and when it is released again.

**Pressed**  **Released**  **Bumped**

**Suggestions for use**

You can use the Touch Sensor to do a lot of things: if a robot has a Touch Sensor connected to a leg it can tell how far it has moved by counting how many times the Touch Sensor has been pressed.

The Touch Sensor can also be used to detect if your robot bumps into an obstacle and reacts to it.

You can also use a Touch Sensor to make your robot act on a command. For example, by pressing or releasing your Touch Sensor, you can make your robot walk, talk, close a door or turn on your TV.

**Try Me**

**Test it!**

Test the Touch Sensor and get a fun reaction.

Connect a Touch Sensor to port 1 of your NXT and select the Try Touch program in the Try Me submenu on the NXT's display.
ULTRASONIC SENSOR

The Ultrasonic Sensor is the other sensor that gives your robot vision. The Ultrasonic Sensor enables the robot to see and detect obstacles. You can also use it to make your robot avoid obstacles, sense and measure distance, and detect movement.

The Ultrasonic Sensor measures distance in centimeters and in inches on the NXT. It is able to measure distances from 0 to 255 centimeters with a precision of +/- 3 cm.

The Ultrasonic Sensor uses the same scientific principle as bats: it measures distance by calculating the time it takes for a sound wave to hit an object and return - just like an echo.

Large-sized objects with hard surfaces return the best readings. Objects made of soft fabric or that are curved (like a ball) or are very thin or small can be difficult for the sensor to detect.

Note that two or more Ultrasonic Sensors operating in the same room may interfere with each other’s readings.

Test it!
Test the Ultrasonic Sensor’s ability to measure distance:
Connect the Ultrasonic Sensor to the NXT.
Select the View submenu in the NXT display.

Select the Ultrasonic Sensor icon and the port where you've connected the sensor.

Measure the distance to an object. For example, move your hand closer to the sensor and watch the readings change.

Select the Try Me submenu on the NXT’s display and test your Ultrasonic Sensor. You'll get a fun reaction.

Suggestions for use
You can use the Ultrasonic Sensor in many different ways. Program a robot to sneak around the house without bumping into things. Or make an advanced burglar alarm robot that reacts to movement as well as light or color settings.
INTERACTIVE SERVO MOTORS

The three Servo Motors give your robot the ability to move. If you use the Move block in the software to program your motors, the two motors will automatically synchronize, so that your robot will move in a straight line.

Built-in Rotation Sensor
Each motor has a built-in Rotation Sensor. This lets you control your robot’s movements precisely. The Rotation Sensor measures motor rotations in degrees or full rotations (accuracy of \(+/-\) one degree).

One rotation is equal to 360 degrees, so if you set a motor to turn 180 degrees, its output shaft will make half a turn.

Test it!
Test the built-in Rotation Sensor’s ability to measure distance:
Connect a motor to the NXT.
Select the View submenu in the NXT’s display.

Select the Motor Rotations item.
Select the port where you have connected the motor.

Now attach a wheel to the motor and measure the rotations as you roll the wheel along the floor.
Select the Try Me submenu on the NXT’s display and test your motors. You’ll get a fun reaction.
1. The motor
2. Tachometer (Rotation Sensor)
3. Built-in gearing
Bluetooth® USING BLUETOOTH

Bluetooth is a technology that makes it possible to send and receive data without using wires or cables. Using Bluetooth, you can exchange programs between your computer and your NXT or even between your NXT and other NXTs. You can also establish a wireless connection between your computer and your robot to control it remotely.

If your computer does not have NXT compatible built-in Bluetooth capability, you must use a Bluetooth USB dongle. Make sure that you use the right type of Bluetooth USB dongle. Read more about the different types of Bluetooth USB dongles to use at www.MINISTORMS.com/bluetooth
CONNECTING YOUR NXT TO A COMPUTER

Before you try to set up a wireless Bluetooth connection, make sure that your computer has Bluetooth capability.

The LEGO NXT has a Class 2 Bluetooth radio. This will have a range of approximately 10 meters when used with a compatible Bluetooth device (class 1 or 2).

MAKING THE CONNECTION TO A PC

1. Make sure that your NXT is turned on. Also make sure that you have Bluetooth set to On and that your NXT is set to be Visible (read how in the Bluetooth submenu on the NXT on page 42). Also make sure that Bluetooth is installed and enabled on your computer. See your computer’s and Bluetooth device’s instruction manuals for details.

2. Find the Controller at the lower right corner of the work area in the software. Click on the NXT window button (the one at the upper left) and the NXT window will open.
Click Scan. Your computer will automatically search for Bluetooth devices.

After a short interval, a list of available Bluetooth devices will appear in the window on the computer screen. Select the device you want to connect to and click the Connect button.

When you connect to a device for the first time, the Enter Passkey window will pop up. Enter the passkey to use with this device (the default passkey is 1234) and click OK.
**NXT TECHNOLOGY**

Enter the passkey on your NXT and confirm the connection by pushing the orange [Enter] button. If you have chosen the default passkey, just click the orange [Enter] button.

In the NXT window, the status of your NXT has now changed from Available to Connected. Your NXT and computer are now connected and can share data.

---

**MAKING THE CONNECTION TO A MACINTOSH**

1. 

Make sure that your NXT is turned on. Also make sure that you have Bluetooth set to On and that your NXT is set to be Visible (read how in the Bluetooth submenu on the NXT on page 42). Also make sure that Bluetooth is installed and enabled on your computer. See your computer's and Bluetooth device's instruction manuals for details.

Find the Controller at the lower right corner of the work area in the software. Click on the NXT window button (the one at the upper left) and the NXT window will open.
Click Scan. The Bluetooth device window will pop up on the screen.

A list of Bluetooth devices will appear in the Select Bluetooth Device window on the screen. Select the device you want to connect to and click the Select button.

The NXT that you want to connect to appears in the NXT window as available. Click the Connect button.
The Pair with a Bluetooth Device window pops up. Select the NXT. Click Pair.

When you connect to a device for the first time, a Passkey window will pop up. Enter the passkey to use with this device (the default passkey is 1234) and click OK.

Enter the passkey on your NXT and confirm the connection by pushing the orange [Enter] button. If you have chosen the default passkey, just click the orange [Enter] button.

In the NXT window, the status of your NXT has now changed from Available to Connected. Your NXT and computer are now connected and can share data.
BLUETOOTH SUBMENU ON NXT

Bluetooth
Select the Bluetooth submenu on the NXT display.

Search
Search for other Bluetooth devices. After you have chosen the Search icon, your NXT will automatically start to search for other Bluetooth devices that it can connect to.

My Contacts
You can see all of your stored Bluetooth contacts in My Contacts. These contacts can automatically connect and send data to your NXT without using a passkey. To add a new contact to the list, you must have been connected to the contact before. Devices which you have been connected to, will automatically be added to the list in My Contacts.

Connections
This menu displays your current connections. You can connect your NXT to three devices at the same time (see Line 1, 2, and 3), while one device can connect to you (on Line 0). Note, however, that while you can be "connected" to up to three devices, you can only "communicate" with one device at a time.
NXT TECHNOLOGY

You can also view the connection status in the NXT window in the Software. There you can change the name of your NXT, connect to other Bluetooth devices and check battery and memory levels.

Check the connection status in the icon bar at the top of the NXT’s display.
If there is no Bluetooth icon shown, Bluetooth is OFF.

- Bluetooth is ON but your NXT is not visible to other Bluetooth devices.
- Bluetooth is ON and your NXT is visible to other Bluetooth devices.
- Bluetooth is ON and your NXT is connected to a Bluetooth device.

Visibility
Use the Visible option to make your NXT visible or invisible to other Bluetooth devices when they do a Bluetooth search.

Passkey
The Passkey ensures that only Bluetooth devices approved by you can connect to your NXT. Whenever you connect to a Bluetooth device for the first time using your NXT, you will be asked for a passkey. Select the preset passkey 1234 or make up your own code. Other Bluetooth devices must know your passkey in order to confirm a connection with your NXT.

On/Off
You can turn Bluetooth functionality on or off. If you turn Bluetooth off, you will not be able to send or receive data over Bluetooth. To save battery power, turn off the Bluetooth function when it is not in use.

Note! Bluetooth is turned off by default.
CONNECTING YOUR NXT TO ANOTHER NXT

1. Select the Bluetooth submenu on the NXT's display.

2. Select the Search icon to search for other Bluetooth devices. Your NXT will automatically search for Bluetooth devices.

3. Depending on how many devices are detected in the area, a list will popup on the NXTs display after a few seconds.

4. Select the device you want to connect to. Remember that you can give each NXT a unique name – see Naming the NXT on page 21.

5. Select which of the three lines of communication you want the connection to be on (1, 2 or 3). You can connect your NXT to three different devices at the same time.

6. If you connect to a device for the first time, your NXT will ask for a passkey. Just press enter to use the default passkey 1234 or make up your own code. The other Bluetooth device must know your passkey in order to confirm the connection. This means that the two NXTs need to enter the same passkey in order to connect.

7. If you want to connect your NXT to more than one Bluetooth device, go to the My Contacts submenu to select a trusted contact or start a new search.
Connecting to more than one NXT
You can connect up to three NXTs or other Bluetooth devices to your NXT at the same time. However, you can only communicate with one device at a time.

Sending files from NXT to NXT
It’s easy to send programs from your NXT to another NXT:

1. Make sure that your NXT is connected to the NXT to which you want to send the program (see page 44, Connecting your NXT to another NXT).
2. Select the My Files submenu in the NXT’s display and select the program you want to send.
3. Select Send.
4. Select which of the connected devices you want the program to be sent to (Line 1, 2 or 3).

Your NXT will now send the file.
SYSTEM REQUIREMENTS

Before installing the LEGO® MINDSTORMS® NXT Software, you must make sure that your computer meets the following minimum system requirements:

**- Microsoft Windows**
- Windows XP Professional or Home Edition with Service Pack 2 or newer
- Intel® Pentium® processor or compatible, 800 MHz minimum
- 1.5 GHz or better recommended
- Windows Vista Service Pack 1 or newer
- Intel® Pentium® processor or compatible, 1 GHz minimum
- 1.5 GHz or better recommended
- CD-ROM drive
- 512MB of RAM minimum
- 700MB of available hard-disk space
- XGA display (1024x768)
- 1 available USB port
- Compatible Bluetooth adapter (optional)*

**- Apple Macintosh**
- Apple Mac OS X 10.4 or 10.5
- PowerPC® G3, G4, G5 processor, 600 MHz minimum
- Intel processor
- 1.3 GHz or better recommended
- DVD-drive
- 512MB of RAM minimum
- 700MB of available hard-disk space
- XGA display (1024x768)
- 1 available USB port
- Compatible Bluetooth adapter (optional)*

* Supported Bluetooth software are Widcomm® Bluetooth for Windows newer than v. 1.4-2.10 SP5 and the Bluetooth stack included in Microsoft Windows XP with Service Pack 2 or newer, Windows Vista or Vista Latest Service Pack, Apple Mac OS X 10.4 and 10.5. See www.MINDSTORMS.com/bluetooth.

INSTALLING THE SOFTWARE

Microsoft Windows
1. Exit all open programs.
2. Insert the CD-ROM
   (If the CD-ROM does not run automatically: Double-click the autorun.exe file on the CD-ROM)
3. Follow the on-screen instructions
SOFTWARE

Select your preferred language.
Follow the on-screen instructions.

Apple Macintosh
Exit all open programs.
Insert the CD-ROM.

Open the "LEGO MINDSTORMS NXT" CD-ROM and double-click Install.
Select your preferred language.
Follow the on-screen instructions.

When the installation procedure is complete, click Finish. You are now ready to use the LEGO MINDSTORMS NXT Software and create programs for cool robotic inventions.
YOUR FIRST PROGRAM

This simple program will make the NXT play a sound file. It will help you understand how to connect your computer to the NXT.

Start the software on your PC or Macintosh by double-clicking the program icon.

Type in the name of your first program, or just click on Go!

First, click on the Sound block icon in the programming palette.
Drag a Sound block and drop it to the right of the Starting point in the work area.
Your program is now ready to download and run.

Make sure you turn on your NXT and connect the USB cable to both your computer and the NXT [see page 18, Connecting the NXT technology].

Locate the Controller in the lower right corner of the work area. Click Download and run (the central button) and listen to what happens.

Congratulations, you have completed your first program!
SOFTWARE USER INTERFACE

A quick overview

1. Robo Center
2. My Portal
3. Tool bar
4. Work area
5. Little help window
6. Work area map
7. Programming palette
8. Configuration panel
9. Controller
10. NXT window
SOFTWARE

1. **Robo Center window**
   Here you can find building and programming instructions for four cool models.

2. **My Portal**
   Access www.MINDSTORMS.com to get new models, programs, sounds, images, tips and tricks and be part of the great LEGO® MINDSTORMS® community.

3. **The tool bar**
   The tool bar provides additional tools enabling you to calibrate sensors, create custom sounds and images for the NXT or create NXT files to share with other MINDSTORMS users.

4. **The work area**
   This is the space on the screen where programming takes place. Drag programming blocks from the programming palette to the work area and attach the blocks to the sequence beam.

5. **Little help window**
   Provides tips and help for the specific function you are using at the moment.

6. **The work area map**
   Use the work area map to get an overview of your program. Click on the work area map and drag it over the part of your program you want to see.

7. **The programming palette**
   The programming palette contains all of the programming blocks you will need to create your programs. The tabs at the bottom of the palette let you switch between the common palette (containing the most frequently used blocks), the complete palette (containing all of the blocks), and the custom palette (containing blocks that you download or create yourself).

8. **The configuration panel**
   Each programming block has a configuration panel that lets you customize the block for the specific input and output that you want.

9. **The Controller**
   The Controller allows you to communicate with your NXT. Transfer programs and files, start and stop programs or change the settings of your NXT.

10. **The NXT window**
    This pop-up window will give you information about your NXT's memory and communications settings.
THE ROBO CENTER

In the Robo Center you will find different robot models that you can build and program to do what you want.

Start by selecting a robot model to build and program. We recommend that you start with the ShooterBot as it is a continuation of the QuickStart model included in the box.

Follow the on-screen building and programming instructions — or solve the challenge on your own.
Test your robot using the challenges provided.

THE PROGRAMMING PALETTE

The programming palette contains all of the programming blocks you will need to create your programs. Each programming block determines how your robot acts or reacts. By combining blocks in sequence, you can create programs that will make your robot come to life.

When you have finished creating your program, download it to the NXT and run it.

Remember to turn on and connect your NXT before downloading a program.
The three programming palettes
To simplify its use, the programming palette has been divided into three palette groupings: the common palette (containing the most used blocks), the complete palette (containing all of the programming blocks), and the custom palette (containing blocks you download or create yourself).

You only need to use the blocks below to complete the challenges. The color sensor blocks can be found in the complete palette, while the others are located in the common palette. The software’s help area has more information about the rest of the programming blocks when you are ready to move on.

- **Move block**
  This block controls the robot’s motors and synchronizes its movements. Use this block to set your robot to go forwards or backwards in a straight line or to turn by following a curve.

- **Display block**
  Use this block to display an image, write some text, or draw a shape on the NXT’s display screen.

- **Record/Play block**
  This block lets you record a physical movement with your robot and then play back the recorded movement elsewhere in the program.

- **Wait block**
  This block lets your robot sense its environment for a specific condition before it continues with the program. For example, use the Wait block to make the robot wait for a specific color, touch or time, before it moves on with the program.

- **Color Lamp block**
  Use this block to turn on the red, green or blue light in the Color Sensor. You can, for example, make your robot shine the red light as a warning signal.

- **Loop block**
  Use this block if you want your robot to do the same thing again and again. For example, make your robot move forwards and backwards continuously until the Touch Sensor is pressed.

- **Color Sensor block**
  This block enables the Color Sensor to identify colors. This makes it possible to have your robot react differently depending on the colors it detects.

- **Switch block**
  This block lets your robot make its own decisions, such as going left when it hears a loud noise and going right when it hears a softer noise.
THE CONFIGURATION PANEL

Each programming block has a configuration panel that lets you adjust the settings of the block for the specific actions that you want. When a block is selected in the work area, its configuration panel will be visible at the bottom of the screen.

By changing the parameters on each configuration panel, you can change how a particular block will behave. For example, to make your robot move faster, you can change the Power property on the Move block’s configuration panel.

THE CONTROLLER

The five buttons on the Controller communicate from your computer to the NXT:

- The Download and run selected button downloads and runs just a piece of your program’s code (e.g., a single block or just a few blocks). Select the blocks you want to test and click on the Download and run selected button. You will then be able to see how the small sequence of your program performs on the NXT without having to download the whole program.
- The Download button downloads the program to the NXT. You can then run the program from the NXT.
- The Stop button stops a running program.
- The Download and run button downloads a program to the NXT and then starts running the program.
- The NXT window button gives you access to the NXT’s memory and communications settings.
SOFTWARE

SOUND EDITOR

The Sound Editor allows you to add your own sounds to the NXT.

You can add sound files already stored on your computer*, royalty-free files found on websites, and even record your own voice and download it to the NXT.

You can find the Sound Editor in the NXT software under 'Tools' in the menu bar. Click on it to open it.

You have the option to either import an existing sound file or record your own sound file.

To import a sound, click on 'Import' and choose a file from the location (on your computer) where you have stored your sound files.

To record your own sound you first need to have a microphone connected to your computer.

Click on the 'Record' button and create a sound into your microphone. You can record up to 10 seconds of sound and edit the length of the recording afterwards.

You can also trim (cut) the size of your sound file by moving the small triangles until the length is as you want it.

Save your personal sound files in the NXT software's library. You can give it a title that is easy for you to remember, for example 'My first sound.'

The Sound Editor displays the maximum size (file size limit) that you can download and store in your NXT's memory.

The sound file will appear in the list of sounds in the Sound Block.

Now you are ready to make your NXT robot say or play whatever sound you want it to!

*You can also download sound files from other sources, like the Internet. Do note that some files may require a license or royalty to be used.
IMAGE EDITOR

Using the Image Editor you can create your own images or stored images and download them to the NXT, so they appear in the display on the NXT!

You can find the Image Editor in the NXT software under 'Tools' in the menu bar.

To import your own image to the Image Editor click 'import' and choose an image from where you store your images. (The default is the library of images that comes with the software.)

You will be able to crop the image and to set the level of detail to be displayed on the NXT.

In the Image Editor you can change your image to fit the size of the NXT display, which is 100 pixels by 64 pixels. You can also change the level of detail from your original image by moving the slider.

You can also create your own image and add text to it using the drawing tools. Once you have adjusted an imported image or have created your own image, you can save it to the image library in the NXT Software.

Now you can access your picture and add it to a program and download it to your NXT.

Try it out!
REMOTE CONTROL

The Remote Control gives you direct control over your robot!

You can find the Remote Control in the NXT software under ‘Tools’ in the menu bar. Click on it to open it.

To take control of your robot you need to have a connection between your PC and your robot. If an active connection already exists, the window will display the name of the connected NXT. You can change the active NXT without closing the Remote control.

Press the arrow keys on your keyboard or on screen with your mouse to drive your robot in the direction of the arrow. The spacebar will activate an action motor on your robot to allow you to move and react at the same time.

If there is no active connection, the screen will say “No NXT Connected” and you will have to choose the NXT you want to control.

You now have direct control and can take your robot for a spin!
TEST PAD

Test all your models on this Test Pad.

This is the starting point on the pad.
TROUBLESHOOTING

Resetting the NXT
If the running icon stops spinning, your NXT has frozen and you will need to reset it. Follow these steps to reset your NXT:

1. Make sure that your NXT is turned on.
2. Push the reset button that is located on the back of your NXT in the LEGO® Technic hole in the upper left corner. Use, for example, an unfolded paperclip to press the button.
   Note: If you press the reset button for more than 4 seconds you will need to update the firmware [see below].

Updating the firmware in the NXT from your computer
Go to Tools > Update NXT Firmware.

1. Make sure that your NXT is turned on and has fresh batteries.
   Note: If you have just reset your NXT [see above] the display will be blank. A ticking sound will tell whether it is turned on or not.
2. Make sure that your NXT and computer are connected with the USB cable.
3. Go to the Tools pull-down menu in the software's menu bar and select Update NXT Firmware.
4. Chose the firmware that came with the NXT software or browse to newer firmware downloaded from the LEGO® website.
5. Click Download.
6. When all three progress bars are green the firmware update is complete.
Select the firmware you want to update. Click download. (Note! The Windows ‘Found new hardware wizard’ will pop up the first time you update your firmware. Complete the wizard by following the on-screen instruction before you continue).

For other types of troubleshooting, go to www.MINOSTORMS.com/support

**FCC approval:**
The LEGO Group hereby declares that the LEGO® MINDSTORMS® NXT (8547) complies with the requirements of the relevant provisions of EU Directive 1999/5/E. Under conditions in which static electricity might occur, the unit might switch itself to standby mode. The unit may have to be reset by the user.
EN  Protect the environment by not disposing of this product with your household waste (2002/96/EC). Check with your local authority for recycling advice and facilities.


IT  Proteggere l'ambiente: non smaltire questo prodotto con i rifiuti domestici (2002/96/EC). Per consigli sulla raccolta dei rifiuti e sulle strutture di raccolta, rivolgersi alle autorità locali.


PT  Proteja o ambiente não eliminando este produto com o seu lixo doméstico (2002/96/EC). Consulente as autoridades locais para informação sobre reciclagem e sistemas de recolha.

EL  Προστατεύετε το περιβάλλον. Δεν πρέπει να αποκαταστείτε το προϊόν μαζί με τα συναρτήματα ακαταπαύσιμης εργασίας (2002/96/EC). Επικοινωνήστε με την οργανική οργάνωση και με τις γκροποποιήσεις για ανακύκλωση.

PL  Aby chronić środowisko naturalne, nie należy wyrzucać tego produktu razem z odpadami z gospodarstwa domowego (2002/96/WE). W celu uzyskania wskazówek dotyczących-recyclingu oraz adresów zakładów należy skontaktować się z lokalnym urzędem.


USEFUL INFORMATION

Quick Build
Schnellbaumodelle
Construction rapide
Costruzione rapida
Snel bouwen
Construcción rápida
Byg hurtigt
Nopean rakentamiseen
Bygg snabbt
Construção Rápida
Γρήγορες Κατασκευές
Kísérletezőknek

Experienced Build
Könermodelle
Construction normale
Costruzione esperta
Bouwen voor gevorderden
Construcción experta
Byg videre
Kokenelle rakentajalle
Bygg mer
Construcción para Experimentados
Εισαγωγικές Κατασκευές
Hadóknak

Advanced Build
Profimodelle
Construction avancée
Costruzione avanzata
Geavanceerd bouwen
Construcción avanzada
Byg avanceret
Tasavallan rakentajalle
Bygg avancerat
Construcción Avanzada
Εξελιγμένες Κατασκευές
Profiknák

LEGO®

BLUETOOTH® is a trademark owned by Bluetooth SIG, Inc. and licensed to the LEGO Group.
LEGO® and the LEGO Group are trademarks of the LEGO Group.
©2009 The LEGO Group

Other product and company names listed are trademarks or trademarks of their respective companies.